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Configuring Settings for IE, Firefox, Safari and Google 

Configuring Settings for Microsoft Internet Explorer 

 

DO NOT USE INTERNET EXPLORER!!! 

An updated was done to Internet Explorer in Mid December 2015 

and PRIMAVERA Unifier does not work with it. 

 
 

Configuring Settings for Mozilla Firefox    

https://www.mozilla.org/en-US/ 
1) Open Mozilla Firefox.  

2) Open Options.  

3) In the Options dialog box:  

a. Select the Content tab.  

b. Deselect (Uncheck) the Block pop-up windows option.  

c. Click OK to save your options and close the dialog box. General Setup Tasks  

 

Configuring Settings for Apple Safari  

 

1) Open Apple Safari.  

2) From the Settings dropdown, select Preferences.  

3) In the General dialog box, select Security.  

4) In the Web Content section, deselect (Uncheck) Block pop-up windows.  

5) Close the dialog box.  

 

Configuring Settings for Google Chrome 

https://www.google.com/chrome/browser/desktop/index.html 
1) In Google click on the Screen with the x in the Address Bar (See below) 

2) Change it to “Always allow pop-ups from cosaprimelink-unifier.oracleindustry.com” 

 
 

If you have already being using Google Chrome,please do the following – 

1)  Click on the 3 vertical dots in the upper right hand corner      

2)  Click on Settings, then click on“Privacy and security”  

3)  Scroll down and find then click on “Content Settings”, Scoll down to and click on “Pop-ups” 

4)  Click on “Add” and input - https://unifier.oraclecloud.com/cosaprime 

5)  Click on “Add” in the lower right hand corner 

6)  Go back to Login Screen 

https://www.mozilla.org/en-US/
https://www.google.com/chrome/browser/desktop/index.html
https://unifier.oraclecloud.com/cosaprime
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Logging into the new ORACLE Access Manager 

 
To login into ORACLE Access Manager, go to https://cosaprimelink-unifier.oracleindustry.com 

   

Main Logon Page 

 
 

You will enter your username that you used in PRIMELink and  

                                              the new password that Oracle or that we sent to you in the email 

 

After you have click on Login, this page will show up.   

Please change your password and select and answer the Challenge Questions.   

 

Your old password is the one Oracle or we told you.  (NOT YOUR OLD PASSWORD) 

 

(Passwords should be at least 8 characters long, with at least one capital letter & one special character  

[{~!@#$%&*()-_=+;:"’,<.>/?}] 

 

Password Change and Secret Question Page 

 

https://cosaprimelink-unifier.oracleindustry.com/
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After you have click on “Submit”, this page will show up.   

1.  To go into PRIMAVERA UNIFIER, click on Unifier 

2.  To change your password or change your proxy, click on Oracle Identity Manager 

 

 

 

 

 

 

 

If you need to change your Password later 

1. To login into ORACLE Access Manager  

2. Click on Oracle Identity Manager  

 

 1.  Click on My Information,  

 2.  then click on Change Password 

 3.  Input your current password in Old Password and input your new password twice then click on “Apply” 

 
 .  

 
 

Click this Icon to open PRIMAVERA UNIFIER 

To change user information such as  
Name, Email, Password, Challenge Questions & Proxies 
Click on the Oracle Identity Manager 
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Navigation, Layout and Upgrades to PRIMELink 

1. The navigation remains the same. It will continue to use tabs for each project and on-call 
contract. The Home Tab will always remain on the upper left corner. Users can continue to 
use the search bar to locate their projects and on-call contracts. Below is a screenshot of 
the updated appearance 

 
 

A. Home Tab (Cannot be removed) 
B. Tab 1  
C. Tab 2 
D. Icon to add tabs and display search bar 
E. REMOVED - Button to switch between new and old interface.   Old interface has been removed.  
F. Bookmarks 
G. Help Menu 
H. Search bar 

 

2. The Home Tab will have an updated appearance. Users will continue to access all of their Tasks, 
notifications, Drafts and Mailbox. 

 

 
 

Click on number to 
view all pending tasks 

Click on view all records 
user copied (CC’d) Click to view internal 

Emails 

Chart displays number all 
late and pending tasks 

A 

B C 
D 

E F G 

H 

Click on line here and you can 
increase or decrease this!!! 
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3. The Tasks Log will have a new appearance. The default view is to display tasks received in 
last 7 days. We highly recommend changing to “All Tasks” to view all outstanding tasks. 
The section on the right displays additional record information such as workflow progress 
and attachments. 

 

 
 

 
 

4.  The form layout has changed a lot!! The Accept and Decline location moved to the upper 
right hand corner, and the Send location move to the upper right hand corner too. 

See the following screenshot.   
 

 
 

  
 

 
 

New Location for Accept and Decline Actions 

Click to View additional information 

NOTE - Please change View to “All Tasks”!!!!! 

Double Click on item to Open Task…. 

New Location for Send Actions,  
Clicking on Send will bring up a new window with Workflow Action Details 
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5. Users using new user interface will have a new form when records are closed/completed. 

The following screenshot shows the new form layout. However, users can switch to the old 
interface to view the classic form layout. Refer to letter E under Section 3 to switch 
interface.  

 

 
 

 

 

 

 
 

6. A user can have multiple proxies from their respective organization.  Users can select their 
proxies under Preferences. See the following screenshot to setup proxies. 

 
  

 

Click on “Proxy” 

Click on + to add new proxies 
 
Select Person and click on Trashcan to remove proxy 

Select your name  
 
    And then click on “Preferences” 

The Standard tab displays the Detail line items. 

This section has the information 
from the upper form 

Click on links to view Attachments, 
Comments and Linked Records 

Or the Invoice Request tab displays the Detail line items. 
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7. Users can print multiple records from the logs into a single file. Users can select 
multiple records by holding down the Ctrl or Shift key. Under Actions select Print and 
then select the format (HTML, PDF, etc.) to generate the file.   

 

 
 

8. When adding line items to Task Orders, Contract Change Requests, etc.,  you can add 
additional items without having to close the entry form. Select the “Save & Add New” 
button to save time when entering line items.   
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9. The Document Manager has 3 different views in the interface - following is screenshots 
of the new views – Flat View, Tile View and Tree View  

 

In the Tile View it displays a thumbnail preview of photographs.  You can also search 
for files across all folders in the Document Manager.  

 
(Flat View) 

 
    (Tile View)     

 
   (Tree View) 

 

Search features 
available to find 
files in 
Document 
Manager or Page 
 

Switch between Tile or 
List View. Tile will 
show thumbnails.  
List is the detailed list 
of files. 

Upload 
Download 

Click to Create 

new subfolders 
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Different Items In PRIMELink 
1. When you click on Tasks you will see something like the below: 

 

 
 

 Tasks: displays all tasks that you have received. Tasks include items that require 
review, approval, comment, etc.  

o A new task appears in BOLD  
o A late task appears in RED 
o A previously viewed task but not completed appears in normal font 

 Messages: displays copies of items which you have been cc’d 

 Drafts: displays saved drafts of items you have created but not sent 

 Mailbox: displays internal e-mail messages sent within the system 
    

To View Items that are more than 7 days old you will need to click on the down arrow 
 

 
 

 

 

 
 

Tasks 
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View Pending Tasks 
2. To View All Pending Tasks: 

a. Click on the Home Tab 
b. Click on Task 
c. Click on the down arrow, then click on All Task 

 
 
Project Specific:  
Go to your project or from Home tab click on the + sign and input your project’s name into the 
search engine and click on it there… 
 
When you click on your project the following will appear –  
You will need to click on Summary to see the Details Page 
 

 
 
Select Tasks from the Dashboard 

 
 

Down Arrow 
 
Then Click 

on All Tasks 

Tasks 

Click on the + sign and  

input the project’s name or number 
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Pending Tasks 

 
This is where you can use the stuff shown to you on Page 6…. 

 
View Draft Records 

 
When you start a new item in PRIMELink (Payment Request, RFI, Submittal or other item) and the 

system drops you out or you have to get out, sometimes the system will store it has a Draft Record.  

Please keep an eye on this item.  You do not want to have a lot of Draft Records.  To clear them do the 

following:  

 

1.  On the Home Screen, click on Draft in the upper right corner 

2.  Highlight the ones you want to delete 

3.  Click on Actions, then on Delete  

4.  If you need to delete more, go back to step 2. 
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CoSA Tab 
 

The CoSA tab contains all the current On-Call Contracts, Projects, ROW Permits and Task 
Order Contracts Group.   The new location is on the close to the top left and select either:  
On-Call Contracts, Project, ROW Permits or Task Order Contracts Group.                                                                                              
    

 

To find you project – find and click on Project 

 

Click on Departments 
And Select either 

On-Call Contracts 
or Project 

or ROW Permits 

 or Task Order Contracts Group 

Click Expand View 
 

Click to Close Map View 
MapView 



15 

 

Letters before Project Names stand for the following: 

A – Aviation Projects 
B – Building and Equipment Services 
E – Environmental On-Call Contracts 
F – Traffic Management/Operations Projects and On-Call Contracts 
H – CIMS and Public Works Horizontal Projects and On-Call Contracts 
J – JOC On-Call Contracts 
K – Parks Department Projects 
P – Public Works On-Call Contracts and Projects 
R – Real Estate On-Call Contracts 
T – Technical Services On-Call Contracts 
V – CIMS Vertical Projects and On-Call Contracts 

           VS – Convention Center Expansion Projects and On-Call Contracts 
 

Click to turn on Search Find View 
 

To open your Contract or Project  
 Yet - Click on the name 

 

To Find your contract or project  
Input part of the name of the item in the Project Find Box 
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Bookmarks 

You can create Bookmarks to frequently accessed Projects or On-Call Contracts. 
 

1. Navigate to the desired Project or On-Call Contract 
2. Click the Bookmarks Star on the upper left section of the window 
3. Click Add to create the bookmark                                                          

 
 
If you want PRIMELink to open at your project, click on Organize then put a Checkmark in the 
Default Logon block.   

 

Bookmarks 
link 

Click “Add” to create 
Bookmark 
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PRIMELink Forms 

You will be completing forms by entering information into form fields or selecting options 
through pickers, drop-down lists, and check boxes. 
 

PRIMELink forms consist of one or more sections: Task Detail Form, Action Location, and 
Data Details Form. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Action Location 

Data Details Form 

Task Detail Form 
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Task Details Form 
 

The Task Details form contains basic information. Fields in all forms will vary: editable, 
required, and read-only fields. 
 

 Editable fields are shown by a white background text box 

 Required fields are shown by a red * after the field 

 Read-only fields are show by a blue-gray text box 

 Pickers allow selecting from a list of options. Once selected, a dialog box will appear 
allowing to select from a list. 

 

 
 

 

If you received an Email about an task 
You must either - click on Accept Task or Decline Task 

Accepting the task does not approve the task… 
Declining the task just mean someone else will be working on it!!! 

Declining a task DOES NOT reject it….. 
  

The Gray items are Read-only field 

The White Fields with the *  are Required field 

You can only 
edit White 

Fields 
Editable fields 

Picker / Selector 

Click here to remove the Information Form 

The White Fields without the *  are 
not required information fields 

Different items have different forms 

If it has a Picker/Selector, if you know the info 
that it is requesting, you can type into that line 
and it will bring in the information 
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Task Details and Data Details Forms 
 
Task Details and Data Detail will show that the task will be assigned to in the next workflow 
step, who it will be emailed to and workflow status. 
 

 
 
 

 
 
 

 

Depending on the setup,  
the To and Cc boxes will 
auto-populate 

Clicking on this arrow 
will bring up 

Different items 
--------- 

See other items below 

Once you accept a task  
and you need to Send  
Click on Send 

Click on Accept,  
Will bring up the item  

You will need to do something with 

This Workflow Actions Details box will open 
Click on Workflow Actions and select who to send  
It to.  (There could me many) 

You can add people to the CC 
Then click on Send to forward the 
Items to the next approver 
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Invoice Request and Standard Data Forms  
 

The Invoice Request and Standard Data Forms contains fiscal information and has the main 
content of the record, such as line items for a payment request, change order and task orders. 
The following is an example of a List Items list. 
 

 

 

 
 

Then find and increase 
 the quantity of the item 

Once you are done, 
Click on Save 

To increase or decrease  
An item, click on the item then 
Increase or decrease its amount 

To Add items, you will need to click on add 

To Add items, you will need to click on add 

Adding on Change Orders  
is done on the left side. 
More information on this in the  
Vendor and Internal Users Manuals 
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Help Files in PRIMELink 

On some items there Help Files at the top, to see if there are help files on an item,  
do the following:  (You must be on your project and on the item you want help with)  
(The User, Admin and Reference Guides are from Oracle and not the PRIMELink Helpdesk 
these will not help you with your problems) 

 
Task Request Contracts Group Help, Field Work Directive Help, PRN Help, RFIs Help 
 
Are just some of the help files that may have a PDF help file.   
 

Most do not have a help file yet. 
 
 

 

 

 

Workflows 

Most business processes in PRIMELink have an associated workflow.  
When you take and action on a form, you are completing a step on the workflow.  
 
Below is a Request for Information (RFI) 

Workflow:  

To Access the Help Files, Click on the this ICON 

Then click on the Help file  
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Assign Task in Workflow 
 

You can assign a task to someone else assuming it is allowed. 
 
1. Open the task 
2. Do Not Accepting the task!! 
3. Click on the 3 horz lines  
4. Click on “Add more assignees…”    
5. Highlight the person(s) or group(s) 
6. Click on the > arrow 
7. Click Done 
 
You will receive a message – “New assignees have been added to ….” 
 

 

 

          

Click on the 3 horz lines  

Click on Add more assignees…  

Highlight the person(s) or group(s) you want to add  
then click on the > arrow 
 
When you are done add people, click on Done 
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Add a Proxy 

Proxy will be utilized when you would like to permit someone else to process items in your 
absence. 
 
1. Click on your name in the top right corner of the page 
2. Click on Preferences 
 

 
 
3. Click on Proxy tab 
4. Click on + plus sign 

 
5. Click on Select 

 Click on Search, Input the first or last name of the person, click Apply 

 Select the name 
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6. Enter Start & End Dates (optional) 
7. Click Ok 

 
 

Remove Proxy 
1. Click on your name in the top right corner of the page 
2. Click on Preferences 
3. Click on Proxy tab 
4. Highlight the name you want to remove 

5. Click on the Trashcan   
 

Login as a Proxy 
 

1. Click on your name in the top right corner of the page 
2. Click on Preferences 
3. Click on Proxy tab 
4. Click on “I am Proxy”  
5. Highlight the name under – Users I can act as their proxy 
6. Click Proxy Logon 
7. You will logon on their behalf 
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User Access Request Form 
 

This form will be used by the PRIMELink Helpdesk to grant and remove access within the system and track who 
requested/authorized the user’s access. 
 

 Form must be completed by the requestor/authorizer within PRIMELink in order to request, remove or modify a 
user’s access to the system. 

 Only personnel who already have PRIMELink access will be able to request/authorize access. 

 User Access form functions as other PRIMELink forms, i.e. form is completed, a Workflow Action is selected and to 
initiate workflow action the user is required to click on Send action button.  Note: Users are able to copy from 
previous requests or individual line items within the form tabs. 

 A single request can be used to request accounts for more than one person, assign a person to more than one 
project, assign multiple people to multiple projects or assign people to both Projects and On‐Call Contracts. 

 
1. Logon to PRIMELink 
2. Click on Company Workspace Tab, click and expand Company Logs line and double-click on the User Access – 

Company business process. 
 

 
 

3. Click New icon on action bar in active window to create a new request 

 
 

Step 1 – Click on Company Workspace 

Step 2 – Click on Company Logs 

Step 4 – Click on User Access - Company 

Step 5 – Click on Create 

List of your previous requests 
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4.  On the beginning of the Create New User Access – Company form, denote in the Remarks text field, a brief 
description of what the access request will entail and/or any other information that will be helpful in understanding 
the request(s). This information is used by the Helpdesk personnel to determine what needs to be done. 

Notes: 

 The first page identifies who is requesting/authorizing the user access. 

 The fields (Record Number, Status, and creation date) in the Header part of User Access form are auto‐populated 
once the request is submitted. 

 
5.  Click on the appropriate Tab(s) to open up the detail portion of form for completion, 
 see Steps 5a – 5d. 

Notes: 

 There are four Detail Forms with tabs entitled  
Accounts, Projects, OnCall Contracts, ROW Permits and Templates.   
User can use more than one tab on a single request. 

 The type of access request determines which tab(s) will need to be completed.   
 
 

 
 

 
5a. Click on Accounts Tab, to add, delete or modify a user’s PRIMELink account.  

 
Click on “Add” function button on the top of the Create New User Access – Company form.  
 

Send Button 
Five Tabs 

Add Button 
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To Add User Account 

1. Select Add from Action drop‐down list.  

IF THE PERSON ALREADY HAS ACCESS TO PRIMELink, DO NOT USE THIS! 
GO TO ONE OF THE OTHER TABS 

2. On the left hand side, the Account Information form will appear.  
a. Must complete all of required fields (marked with red asterisk *) 

3. Ignore the Name field (i.e. user will be unable to find name in name list since access has not been 
established yet) and complete the remainder of the fields in the account information tab. 
4. For Non‐City Employee Account(s) - Please attach the appropriate agreements and answer the questions 
in the New Non‐City Accounts section. If this is the first PRIMELink account for the business, then a Business 
Agreement is also required.   Both agreements are available at  
 
https://www.sanantonio.gov/TCI/Current-Vendor-Resources/COSA-PRIMELink 
  
Note: An individual user agreement is required for every non-city employee requesting an account. 
 
5. For City Employee Account(s) - Complete the New City Accounts section. Note: If your department or 
division is not on the list, put the information in the remarks field. The user id is the same as your COSA 
computer logon id. 
6. In remark field, enter any other information that will be helpful for the PRIMELink Helpdesk. 
7. Click on either “Save” or “Save & Add New” 
 

 
 

To Delete User Account 

1. Select Delete from Action drop‐down list. 
2. Use the Name field selection button to find the user you want to delete. Once selected the remainder of the 
information will be filled out. 
3. Denote in Remarks field, if this person was on any workflows or other considerations such as replacing 
this person with someone else in the workflows. 
Note: This action will prevent the user from accessing system for any project. If you want to remove person 
from a select project or on‐call contract use the Projects or On‐Call Contract tabs. 

 

To Modify User Account 

1. Select Modify from Action drop‐down list. 
2. Use the Name field selection button to find the user you want to modify their profile information.  Once 
selected the remainder of the information will be filled out. 
3. Denote in Remarks field, what changes you want the Helpdesk to make on the user’s account. 
Note: Use this action to change phone numbers, emails or other account information. This will not change 
what projects or on‐call contracts the person has access to. 

 

https://www.sanantonio.gov/TCI/Current-Vendor-Resources/COSA-PRIMELink


28 

 
5b. Click on Projects Tab, to add, delete or modify a user’s PRIMELink account access to a project. 
 
Use the scroll bar on right side of window to view and complete all of requested information. 
Click on Add function button on the bottom of the Project Tab detail section. 
 
Note: A separate line item is required for each user/project combination. If you need to give a person access to 
several projects, create the line item for the first project, then copy the line item, open the new line item and change 
the project along with any change in remarks.  
 
Must complete all of required fields (marked with red asterisk *) 
 
 
Add, Delete or Modify User Account Access to Project 

1. Select appropriate action from Action drop‐down list: 
a. Add – if user wants to add user access to a project 
b. Delete – if user wants to remove user access to a project 
c. Modify – if user want to change what a user role on a project 

2. Use the Name field selection button to find the user you want to add/delete/modify. Once selected the 
remainder of the information will be filled out. Note: If the user does not yet have an account you will have to 
type in the first name, last name and company fields. 
3. Choose the Project Role that best fits the user. 
4. Use the Project ID selector button to find the project. Note: If you can’t find the project, manually enter the 
project name into the Project Name field. 
5. Denote in Remarks field, a brief description of what the person will be doing on the project. 
This is used by the Helpdesk personnel to determine exactly which groups within the project the person 
needs to be in. The groups determine what the user is able to see and do. 
6. Click on either “Save” or “Save & Add New” 
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5c. Click on On-Call Contracts Tab, to add, delete or modify a user’s PRIMELink account access to an on‐call contract.  
 
Use the scroll bar on right side of window to view and complete all of requested information. 
Click on Add function button on the bottom of the On-Call Contracts Tab detail section. 
 
Note: A separate line item is required for each user/on‐call Contracts combination. If you need to give a person 
access to several on‐call Contracts, create the line item for the first on-call Contracts, then copy the line item, open 
the new line item and change the on‐call Contracts along with any change in remarks. 
 
Must complete all of required fields (marked with red asterisk *) 
 
Add, Delete or Modify User Account Access to On-Call Contracts 

1. Select appropriate action from Action drop‐down list: 
a. Add – if user wants to add user access to a on‐call Contracts 
b. Delete – if user wants to remove user access to a on‐call Contracts 
c. Modify – if user want to change what a user role on a on‐call Contracts 

2. Use the Name field selection button to find the user you want to add/delete/modify. Once selected the 
remainder of the information will be filled out. Note: If the user does not yet have an account you will have to 
type in the first name, last name and company fields. 
3. Choose the On‐call Contracts Role that best fits the user. 
4. Use the On‐call Contracts ID selector button to find the on‐call Contracts. Note: If you can’t find the on‐call 
Contracts, manually enter the on‐call Contracts name into the On‐call Contracts Name field. 
5. Denote in Remarks field, a brief description of what the person will be doing on the on-call Contracts. This 
is used by the Helpdesk personnel to determine exactly which groups within the on‐call Contracts the 
person needs to be in. The groups determine what the user is able to see and do. 
6. Click on either “Save” or “Save & Add New” 
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5d. Click on Templates and ROW Permits Tabs, to add, delete or modify a user’s PRIMELink account access on templates. 
 
Use the scroll bar on right side of window to view and complete all of requested information. 
Click on Add function button on the bottom of the Templates Tab detail section. 
 
Note: This detail tab is used for only those individuals in  
Fiscal, Contract Services, Director’s Office, Division Managers, Utility (SAWS/CPS Energy) and TxDOT access groups. 
 
Add, Delete or Modify User Account Access to Templates 

1. Select appropriate action from Action drop‐down list: 
a. Add – if user wants to add user access across all existing projects 
b. Delete – if user wants to remove user access from all existing project workflows  
(i.e. project templates) 
c. Modify – if user want to change what a user’s role on project template 

2. Use the Name field selection button to find the user you want to add/delete/modify. Once selected the 
remainder of the information will be filled out. Note: If the user does not yet have an account you will have to 
type in the first name, last name and company fields. 
3. Choose the Template Role that best fits the user. 
4. Denote in Remarks field, a brief description of what the person will be doing on the On-Call Contracts. This is 
used by the Helpdesk personnel to determine exactly which groups within the on‐call Contracts the person needs 
to be in. The groups determine what the user is able to see and do. 

 

 
 

6. Upon completing the appropriate detail tab(s) part of the form. Click in “Send” in the upper right hand corner.  
Then click on “Send” again on the Actions Details page. 
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Reports – User-Defined and Custom Reports 
 
There are many reports in the PRIMELink system that you can use to find out information about your Project or 
On-Call Contract current items.  To find out want reports are available to you do the following: 
 

1. Go to your Project or On-Call Contract 
2. Go to the bottom of the menu and click on “Reports” 
3. Select “User-Defined” or “Custom Report” 
4. Under “User-Defined” you may see the following: 

 

 
 

5. Under “Custom Reports” you may see the following: 

 
 

6. Under “Inspector Qty Reports” you may see the following: 
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7. Under each report you will find a different kind of request page – 

 
a. Next to Agency you can click on Select, you will see this 

                     
Click on the one you want or leave it blank 

 
b. Same for Type of Contract  

                
Click on the one you want or leave it blank 

 
c.  At the Top -  select either CSV or PDF. 

i. CSV will give you a spreadsheet of the items 
ii. PDF will give you a PDF of the items. 

 
8. Go to the bottom and click on Run Report to get the report you are requesting. 

 
 

If you are using Google Chrome cannot view a PDF file in PrimeLink, it could be because Google 

Chrome has its own version of a PDF Viewer and it needs to be disabled! 

 

To do that: 

 

1) Right click on Google Chrome icon 

2) Click on the Google Chrome name 

3) In the top message bar are, type in “about:plugins” and hit Enter 

4) Click on Disable Chrome PDF Viewer 
 


